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Introduction 

This White Paper is a practical guide for technical users, installers, system 

administrators, and programmers who implement, maintain, or develop applications for 

your PeopleSoft system.  In this White Paper, we discuss guidelines on how to implement 

and diagnose a Communication Generation environment. 

Much of the information contained in this document originated within Oracle. Although 

every conceivable question that one could encounter does not appear in this document, 

the issues that appear are the questions that prove to be the most common. 

Keep in mind that Oracle updates this document as needed so that it reflects the most 

current feedback we receive from the field. Therefore, the structure, headings, content, 

and length of this document are likely to vary with each posted version. To see if the 

document has been updated since it was last downloaded, compare the date of your 

version to the date of the version posted on My Oracle Support. 

We assume that our readers are experienced IT professionals, with a good 

understanding of PeopleSoft’s Internet Architecture.  To take full advantage of the 

information covered in this document, we recommend that a user have a basic 

understanding of system administration, Internet architecture, relational database 

concepts/SQL, and how to use PeopleSoft applications. 

This document is not intended to replace the documentation delivered with PeopleSoft 

Enterprise PeopleBooks.  We recommend that before a user read this document, the 

user read the related documentation in the Campus Solutions 9.0 PeopleBooks. 

Many of the fundamental concepts about Communication Generation and affiliated 

functionality are discussed in the following resources: 

• PeopleSoft Enterprise Campus Community Fundamentals 9.0 PeopleBook:  Setting 
Up Communications and Managing Communications 

• Enterprise PeopleTools 8.XX PeopleBook:  XML Publisher for PeopleSoft Enterprise 

• Oracle XMLP Core Components Guide 5.6.3 
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Chapter 1 – Understanding the Communication Generation 
Process 

Communication Generation is a new feature delivered in Campus Solutions Release 9.0 which 

relies on the underlying 3Cs structure and Campus Community setup features, including the 

following: 

• Setting Up and Assigning Communications 

• 3C Group Security 

• Administrative Functions 

• Variable Data 

• Usage Tables for Name, Address and Joint Salutation 

Communication Generation is an Application Engine process named SCC_COMMGEN.  The 

process leverages fusion integration with Oracle XML (Extensible Markup Language) Publisher 

(also known as Oracle Business Intelligence Publisher).  XMLP/BIP is a PeopleTools feature 

that enables a user to manage and merge XML document templates and communication data 

source files for the process to generate communications.  

This feature expands on the functionality provided by Letter Generation (CCLTRGEN) to 

extract data for communications, but is greatly enhanced to support additional features such as 

the following: 

• Generate hard copy letter or e-mail, labels, and envelopes. 

• Utilize communication preferences, including preferred method and language. 

• Preview generated output. 

• Extract only data needed for a specific template. 

• Select a subset of IDs to generate communications using Population Selection feature. 

• Extract Checklist information from different Administrative Functions. 

• Select specific organization contact, department and location. 

The basic steps for setting up Communication Generation are as follows: 

1. Design a communication plan. 

2. Set up the 3Cs structure. 

3. Create one or more queries (or application classes) which select the additional record fields 

to be used in the Communication Data Source. 
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4. Create a Communication Data Source and tie any custom queries (or application classes) to 

the Data Source Definition. 

5. Finalize the XMLP Document Template. 

6. Create a Report Definition to link the XMLP Document Template with the Communication 

Data Source. 

7. Associate the Letter Code with the Report Definition. 

CONSIDERATIONS BEFORE IMPLEMENTATION 

There are various items that should be considered prior to implementing Communication 

Generation, including the following: 

1. Choose a user design tool.  XML Publisher report formats can be designed using Microsoft 

Word or Adobe Acrobat Pro.  Microsoft Word is a familiar standard word processor with a 

lot of flexibility.  Forms created in Adobe Acrobat Pro, which are much more complex, can 

be built to ensure that they are filled out correctly.  This paper covers the use of Microsoft 

Word as the design tool. 

2. Decide how the correspondence will be delivered to its audience.  Delivery methods are 

hardcopy or e-mail.  Output options include send to printer, send to file, create envelopes, 

and create labels.  The default output format for hardcopy delivery methods is PDF.  Email 

output should be in HTML format. 

3. Determine the layout of the correspondence by creating a mockup of the communication.  

More complex layouts using Word may need advanced merge logic, or formatting switches, 

embedded within the template (e.g. format of date and addresses). 

4. Review and decide which Administrative Function should be used to extract the appropriate 

data for the communication (e.g. ADMP, EVNT, PROP).  For each variable, you’ll need to 

identify the corresponding record field from which to get the data.  Users are encouraged to 

use PeopleTools Query to select record fields not already included with the standard 

Administrative Function variable data fields. 

5. Estimate how large the audience will be.  This is important in determining if the bursting 

feature, which enables a single data extract file to be separated into relevant content for 

hundreds or thousands of recipients, should be used.  For the query tool, the recommended 

maximum is 50,000 rows of data. 

SERVER RECOMMENDATIONS 

As part of normal processing, XML/BI Publisher generates temporary file(s) that are directly 

related to the size of the XML data file(s) generated by the Communication Generation process. 
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The size of the Sample Data File generated by the process when a user registers a 

Communication Data Source should provide an approximation of the data file.  Once this size 

has been determined, use the following to calculate the size of an XML Data File: 

XML Data File Size = (size of Sample Data File) x (total number of transactions to process) 

Temporary file(s) generated by XMLP/BIP could be anywhere from 3 to 5 times the size of the 

XML Data File.  Consider increasing the default Java heap size gradually to accommodate 

posting files that are five megabytes (MB) or larger. 

System and global properties for XML/BI Publisher should be configured as part of the initial 

setup.  The default xdo.cfg file, located in the $PSHOME/appserver directory, is as follows: 

Example for PeopleTools 8.49.XX: 

<config version="1.0.0" xmlns="http://xmlns.oracle.com/oxp/config/"> 

<properties> 

<!-- System level properties --> 

<property name="xslt-xdoparser">true</property>  

<property name="xslt-scalable">true</property> 

<property name="system-temp-dir">CACHE</property> 

<property name="system-cachepage-size">50</property> 

<!-- PDF compression --> 

<property name="pdf-compression">true</property> 

<!-- PDF Security --> 

<!-- <property name="pdf-security">true</property> --> 

<!-- <property name="pdf-open-password">user</property> --> 

<!-- <property name="pdf-permissions-password">owner</property> --> 

</properties> 

</config> 

Additional information is located in Enterprise PeopleTools 8.XX PeopleBook:  XML Publisher 

for PeopleSoft Enterprise > Setting Up XML Publisher. 

PREREQUISITES 

There are key elements that need to be set up prior to the implementation of Communication 

Generation. 
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1. Define name usages by navigating to Set Up SACR > Product Related > Campus 

Community > Establish People Processing > Setup > Name Usage Table (Record:  

NAME_USAGE_TBL). 

2. Define address usages by navigating to Set Up SACR > Product Related > Campus 

Community > Establish People Processing > Setup > Address Usage Table (Record:  

ADDR_USAGE_TBL).  If e-mail will be a communication method, a user needs to make 

certain that an address usage contains at least one E-Mail Usage Type. 

3. Define organization recipient usages by navigating to Set Up SACR > Product Related > 

Campus Community > Establish People Processing > Setup > Organization Recipient 

Usage (Record:  SCC_ORG_USAGE).  When either All IDs, All Org IDs, or One Org ID is 

selected on the Communication Generation run control, at least one usage is required. 

4. Determine if templates will be designed to distribute correspondence depending on 

Communication Preferences, including the support of multiple languages and methods.  

Based on settings defined on the Installation Default – CC page (Navigation:  Set Up SACR 

> Install > Campus Community Installation), the appropriate languages and methods of 

communications should be selected.  This data can be collected in Self Service (Navigation:  

Self Service > Campus Personal Information > Communication Preferences) or updated by 

administrative users (Navigation:  Campus Community > Personal Information > 

Biographical > Personal Attributes > Communication Preferences). The Communication 

Generation process can generate e-mails and letters at the same time only if you use the 

Communication Preferences feature. 

5. When the Communication Preferences feature is not used, one type of communication 

method can be used to process communications, such as E-mail or hard copy Letters.  Select 

“Support multiple methods” and add each method on the Installation Default – CC page 

(Navigation:  Set Up SACR > Install > Campus Community Installation). 

6. Install the XML Publisher Word Plug-in on user desktops.  To accomplish this task, navigate 

to Reporting Tools > XML Publisher > Setup > Design Helper.  Click the Plug-in link and 

save the xmlp_desktop.zip file to the Temp folder.  Unzip, or extract, the files.  Run the 

setup.exe found in the XMLP_DESKTOP folder.  A user may also download from the 

following Oracle Technology Network (OTN) BI Publisher downloads website:  

http://www.oracle.com/technology/software/products/publishing/index.html. The 

download and installation processes take about 15-20 minutes.  A tutorial and samples are 

included with the installation.  If the error ‘Compile error in hidden module:  

Module_starter’ is encountered, this is due to the installation of Microsoft Security Update 

KB936021.  The following workaround is available: 

a. Navigate to the Start Menu on PC, then Program Files > Oracle > XML Publisher 

Desktop > Template Builder for Word-Bin. 

b. Double-click on the file “ChangeUILang.exe”. 
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c. Select the appropriate language and click OK.  This will register the User Interface 

language. 

7. Provide the appropriate security access to Pages, Processes, Component Interfaces, Web 

Libraries, and Secure Student Administration.  Access to the delivered security role “XMLP 

Report Developer”, which uses permission list PTPT2600 and provides access to all XML 

Publisher components (including setup capability on the advanced feature Report Definition 

Bursting page) should be considered.  In addition, the delivered role “XMLP Power User”, 

which uses permission list PTPT2500, provides access to Query data sources for ad hoc 

reporting through Query Report Viewer and Query Report Scheduler.  It also provides 

access to report definitions and to the Content Library, although access to the report 

definition bursting information is Display Only. 

8. In preparation for using the e-mail communication method, set Process Scheduler SMTP 

settings (refer to Enterprise PeopleTools 8.XX PeopleBook:  PeopleSoft Process Scheduler - 

Using the PSADMIN Utility:  Editing the PeopleSoft Process Scheduler Configuration File).  

The file can be found using the following path: 

 

<ps_home>\appserv\prcs\<databasename>\psprcs.cfg 

 

Open the file using an application such as Notepad.  The SMTP should be configured as 

below, changing server and sender settings as appropriate: 

 [SMTP Settings] 

;===================================================== 

; Settings for SMTP mail 

; All controls under SMTP Settings can be dynamically changed 

;===================================================== 

SMTPServer=[machine].[internet address] 

SMTPPort=25 

SMTPServer1==[machine].[internet address] 

SMTPPort1=25 

SMTPSender=[SMTP-USER]@[internet address] 

SMTPSourceMachine=%PS_MACH%.[internet address] 

SMTPCharacterSet=UTF-8 

SMTPEncodingDLL= 
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SMTPTrace=0 

SMTPSendTime=0 

9. Ensure that the user desktop has a minimum of Java 1.3 or higher.  This software can be 

downloaded for free at http://java.com. 

10. Install Adobe Acrobat on the Process Scheduler. 

11. Confirm that the directory, [PS_HOME]/appserv/PRCS/[domain]/CACHE, exists on the 

process scheduler server. 

Chapter 2 – Defining and Registering a Communication Data 
Source 

There are key settings and rules that need to be implemented to successfully define the 

Communication Data Source (Record:  SCC_CG_DTASRC).  To begin, navigate to Campus 

Community > Communications > Set up Communications > Communication Data Source. 

IMPORTANT:  The XMLP Data Source from within PeopleTools does not work with 

Communication Generation. 

CREATING THE DATA SOURCE 

The Data Source Map ID should be unique and have a naming convention that is easily 

searchable, such as the delivered examples.  This ID links the XML/BI Publisher data source to 

the Communication Generation process metadata.  Using the Register Data Source button on 

the bottom of the page automatically stores the data source inside the PeopleTools tables 

(PSXPRPTTMPL, PSXPTMPLDEFN). 

The Object Owner ID, which is optional, provides portal owner security to modify the data 

source.  Information relating to this can be found in Enterprise PeopleTools 8.XX PeopleBook:  

Internet Technology - Administering Portals. 

The Administrative Function identifies what key data should be added to an ID’s 

communication, checklist, or comment record when a specific communication category, checklist 

code, or comment category is assigned.  Once the Tab key is pressed, the Generic Process Data 

section is populated.  This is a list of generic data that is always extracted.  A user can prioritize 

the order of the records using sequencing. 

The Critical Data check box must be selected to identify specific data that is required to generate 

a communication, such as an e-mail address when using the e-mail communication method.  On 

the Communication Generation run control page, a user can specify what to do if critical data is 

missing: either to process the communication without the data or not to process the 

communication for IDs that are missing the data. 
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Custom extract data can also be identified in addition to the generic process data to identify 

additional data to extract for a communication.  A Query or Application Class can be used to 

identify custom fields.  In this paper, we will discuss using queries only. 

 

 

Figure 1:  Communication Data Source Page 

RULES FOR USING QUERY 

The PeopleTools Query tool (Navigation:  Reporting Tools > Query > Query Manager) is used 

to create most communication data sources.  The query defines the ‘what’, or from what 

additional data fields the process should extract data to merge to the communication.  This query 

should not define ‘who’ should receive the communication.  When using Query in conjunction 

with RTF template-based files, design the data source structure to be as close as possible to the 

actual document template structure to improve runtime performance.   

The following rules must be met to enable a query for use within Communication Data Source: 

1. The Query must be based on the administrative function used in the Communication Data 

Source setup. 

For example, the Communication Data Source uses administrative function ADMP.  The 

query must include the record ADM_APPL_PROG (see Appendix A for list of 

administrative functions and their associated record). 

2. Minimally, the query must include one query prompt to retrieve a person ID or organization 

ID, or a combination of the two. 
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3. If the administrative function has related variable data, you must create query prompts only 

for the variable data associated with the core record and add the prompts as criteria. 

IMPORTANT:  The process only accepts query prompts for retrieving a person and/or 

organization ID as noted in #2 and variable data fields associated with the administrative 

function that is specified in the communication data source (see Appendix A for list of 

administrative functions and their associated variable data fields). 

4. For Person ID or Organization ID prompts used in the query, a Unique Prompt Name must 

be created.  A user can populate the Unique Prompt Name by clicking the Edit button on 

the corresponding Prompts page of the Query Manager component.  Then, change the value 

in the Unique Prompt Name field to a value that will prompt for the desired data.  This is 

the only way the process will know what data to pass to the prompt list. 

a. For Person ID prompts, the unique prompt name must be “PERSON_ID”.  The 

typical key field for persons in transaction tables is EMPLID.  However, entering 

PERSON_ID enables the process to select person data from tables with a different 

person ID key field.  For example, the process searches for PERSON_ID and will 

assign the COMMON_ID for person communications to the query prompt.  See the 

image below as an example (BIND1 is replaced with PERSON_ID as Unique Prompt 

Name value): 

 

Figure 2:  Edit Prompt Properties Subpage with Modified Unique Prompt Name 

b. To prompt for organization ID, enter the Unique Prompt Name of “ORG_ID”.  The 

typical key field for organizations in transaction tables is EXT_ORG_ID.  However, 

entering ORG_ID enables the process to select organization data from tables with a 

different organization ID key field.  The process searches for ORG_ID and will assign 

the COMMON_ID for organization communications to the query prompt. 
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c. To prompt for both person ID and organization ID, enter the Unique Prompt Name of 

“COMMON_ID”.  The typical key field used in shared transaction tables is 

COMMON_ID. Entering COMMON_ID enables the process to select person and 

organization data from shared tables with a different common ID key field. The process 

searches for COMMON_ID and assigns the COMMON_ID for person and 

organization communications to the query prompt. The process uses the SA_ID_TYPE 

field at run time to place the COMMON_ID for the communication into the correct 

person or organization query prompt field. 

5. Based on the Data Source Context selected for the Communication Data Source, the Query 

prompt(s) will be validated when the Register Data Source button is clicked. The steps in 

validating any given Data Source Context are as follows: 

a. Validate the Person/Organization Context: 

1) Person only - Valid unique prompt names include PERSON_ID, COMMON_ID 

and SEQ_3C. 

2) Organization only - Valid unique prompt names include ORG_ID, COMMON_ID 

and SEQ_3C. 

3) Person and Organization combined - Valid unique prompt names include 

PERSON_ID, ORG_ID, COMMON_ID and SEQ_3C. 

b. Validate the Administrative Function Context.  Valid Unique Prompt Names include 

the record.field VAR_DATA_%.FIELDNAME, where “%” is the value of the 

Administrative Function used in the Data Source Context.  The valid values are the 

actual field names used in the dedicated Variable Data table for the Administrative 

Function selected (refer to Appendix A for a comprehensive list). 

6. When using the Search/Lookup for the Query Name on the Communication Data Source 

page, logic evaluates the settings in the Data Source Context section on the Communication 

Data Source page (which comes from the administrative function) and returns queries as 

follows: 

a. Person = Y and Org Y: Prompt returns queries set with prompts for Person ID and 

Org ID. 

b. Person = Y and Org N: Prompt returns queries set with prompts for Person ID only. 

c. Person = N and Org Y: Prompt returns queries set with prompts for Org ID only. 

If a query is set with Person ID and Org ID prompts with an 'or' condition between the two, 

the process will still consider the query to be valid when both Person and Org checkboxes 

are turned on in the Communication Data Source page.   Additionally, the system evaluates 

which queries contain the record that contains the variable data fields from the 

administrative function indicated on the page, and restricts the return to those queries. 
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7. Avoid using Expressions as part of a field or criteria, as the process may abend abnormally.  

An example is “(CONVERT(CHAR(10),D.EFFDT,121))”. 

8. The Max Nbr, or maximum number, is specific to queries only.  This number can be used to 

restrict the number of rows selected into a Standalone Rowset by passing a maximum 

number into the Rowset Fill method.  Normally, this is accomplished within the selection 

criteria of the query and this value can be left blank. 

REGISTERING THE DATA SOURCE 

Once the custom extract data query or application class has been added (if applicable), click on 

the Register Data Source button to synchronize the communication data source with the 

PeopleTools record.  The audit information fields will be populated by the system. 

Click on the View/Download Sample Data File link and save the file in a directory of your 

choice with the extension of xml.  This file will be needed to load into the XML template using 

the delivered design helper tool during a later step.  The file contains all the fields that the 

Communication Generation process will extract, which can be included as variables in a 

template(s). 

IMPORTANT:  When a change is made to the Communication Data Source, including any 

update to the query or application class, the system re-activates the Register Data Source button.  

The Data Source must be registered again for the system to accept and use the changes and 

synchronize it with the PeopleTools record. 

Chapter 3 – Creating an XML Publisher Document Template 

This chapter is a supplement to and does not replace the Oracle XMLP Core Components Guide 

and Enterprise PeopleTools 8.XX PeopleBook:  XML Publisher for PeopleSoft Enterprise.  

XML/BI Publisher is a standalone Java-based reporting technology that provides users with the 

ability to design and create document templates with common desktop applications such as 

Microsoft Word and Adobe Acrobat.  For this paper, we will be discussing an overview of the 

creation of templates using Microsoft Word. 

USING MICROSOFT WORD 

The XML/BI Publisher Word Plug-in, or Template Builder, is a wizard extension of Microsoft 

Word that simplifies the creation of RTF templates.  Template Builder demos, which are loaded 

during installation of the Template Builder, can be found in the following location on a user’s 

hard drive:  C:\Program Files\Oracle\XML Publisher Desktop\demos.  In addition, sample 

templates can be found in the following location:  C:\Program Files\Oracle\XML Publisher 

Desktop\samples.  It is recommended that this information is reviewed prior to building a 

template. 
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The Template Builder allows a user to perform the following functions: 

• Insert data fields 

• Insert data-driven tables 

• Insert data-driven forms 

• Insert data-driven charts 

• Preview template with sample XML data 

• Browse and update the content of form fields 

• Extract boilerplate text into XLIFF, or XML Localization Interchange File Format, and test 

translations 

• Integrate with many of Microsoft Word’s native formatting features (e.g. If-Then-Else) 

• Create sub-template(s) which can contain common elements (e.g. logo) 

When the Template Builder is installed, a user should see a new toolbar that looks similar to the 

following and/or a new menu option called Template Builder: 

TEMPLATE BUILDER MENU   

DATA INSERT PREVIEW TOOLS HELP 

Load XML Data 

Load XML Schema 

Load Report* 

SQL Report Wizard* 

Field 

Table Wizard 

Table/Form 

Pivot Table 

Chart 

Repeating Group 

Conditional Format 

Conditional Region 

All Fields* 

PDF 

HTML* 

EXCEL* 

EXCEL 2000* 

RTF* 

PowerPoint* 

Field Browser 

Validate Translation 

Translate Template 

Export Options 

Help 

About 

*Menu items not commonly used for Communication Generation 

Following are general guidelines to consider when creating a template from scratch: 

• Use the standard Letter (8 ½ x 11 inches) size for templates. Most documents are destined for 

a printer, so using custom paper sizes is not going to work once the document is printed. 

Where the standard paper size is A4, the rendering engine will scale the report up to the A4 

size. 

• For portrait orientation the margins should be set to: 

Left: 0.5 inches Right: 0.5 inches 
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Top: 0.75 inches* Bottom: 0.75 inches* 

*The size of the header and footer may need to be increased or decreased depending on the 

data to be included. 

• In general, use 9 point black font for all text. Do not use a smaller font, as this will cause 

readability problems when the document is translated to a glyph-based language such as 

Chinese or Japanese. 

• Allow additional space for translation expansion. Most translated strings will fit within 75% 

translation expansion but some, particularly short strings, can take up to 150%. 

• Do not format the document by using characters (e.g. underlines, dashes). 

• If a hyperlink is used in the template, ensure not to hardcode the URL. Using hardcoded links 

may work during testing, but the template is going to fail once used by the Communication 

Generation process (see section below, Special Formatting – Hyperlink). 

• The template content and layout must correspond to the content and hierarchy of the XML 

data file. 

• Each group of repeating elements in the template must correspond to a parent-child 

relationship in the XML data file. 

• Preview is essential to catch errors and review how it will look before uploading the template 

to the Report Definition. 

• Templates and sub-templates must be saved as an RTF file to work with Communication 

Generation. 

Creating an RTF template for a letter or e-mail can be done by using the basic steps below: 

1. Open the document that will be used as the template in Microsoft Word. 

2. Load the sample XML data by navigating to Data > Load XML Data.  Select the XML 

sample data file.  A user will receive a message that the data was successfully loaded.  Click 

OK. 

3. Begin to add fields into the template by navigating to Insert > Field.  Position the cursor 

where a user wants to insert the field.  Select the field from the Field Dialog box and click 

Insert, or double-click the field in the Field Dialog box to insert the field.  Select another 

data field or exit the window by clicking the Close button.  (Note:  If a user sees 

{FORMTEXT}, rather than the fld_[field name], navigate to Tools > Options > View to 

turn off Field Codes or select Alt+F9.  If field codes are printing, rather than field results, 

deactivate Field Codes by navigating to Tools > Options > Print.) 

4. Save the document as Rich Text Format (*.rtf). 
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5. Navigate to Preview > PDF to view the layout of the document.  This is essential to catch 

any errors in syntax and to get a better idea of how the communication will look to the 

recipient. 

SPECIAL FORMATTING 

Microsoft Word picks up only the data and none of the formatting stored in the application 

interface.  A user will need a way to display values in the format desired.  The easiest method is 

to add formatting switches to the field codes. 

DATE 

Dates can be formatted in Template Builder by using one of the methods described below: 

1. Specify an explicit date format mask using Microsoft Word’s native date format mask. 

2. Specify an explicit date format mask using Oracle’s format-date function. 

3. Specify an abstract date format mask using Oracle’s abstract date format masks 

(recommended for multilingual templates). 

Only one method should be used.  If both the Oracle and Microsoft format masks are specified, 

the data will be formatted twice, causing unexpected behavior. 

To change the merge result date to letter format, display the field codes and add a date 

formatting switch similar to the example below: 

January 17, 2010 { MERGEFIELD “fld_COMM_DT” \@”MMMM d, yyyy” } 

Notice the uppercase M for the month; lowercase m displays minutes. 

HYPERLINK 

Microsoft Word can create a hyperlink using a Hyperlink field.  The TEXT (URL) can be passed 

through the mail merge and nest the merge field into a Hyperlink field.  This has to be done as 

the last action in the template design.  Following are the steps for creating executable hyperlinks: 

1. Set up the merge document with everything, up to the hyperlink. 

2. Press Ctrl+F9 to insert a pair of field brackets. 

3. Type the field name: Hyperlink, followed by a space. 

4. Insert the mergefield containing the URL to which a user wants to link. 

The result should look something like this: 

{ Hyperlink { Mergefield HyperlinkURL } } 

or like this:  
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{ Hyperlink http://www.oracle.com } 

5. Execute the merge immediately to a new document (Note that this only works in a merge to 

a new document, as a user has to be able to force the field updates.). 

6. In the merge result file, press Ctrl+A, then F9 to update all the fields. 

7. Press Alt+F9 to toggle the field codes off. 

There should now be a different Hyperlink for each merged record.  The displayed text will be 

the URL from the merge field.  There is no way to affect what the displayed text will be using 

mail merge. 

INSERTING IMAGES 

Inserting images into a template can be accomplished using one of the two methods described 

below: 

1. Directly insert or add the jpg, gif, or png image in the template.  When a template is created 

with an embedded image, the wrapping style must be set to INLINE. 

a. To do this in Microsoft Word 2000 or 2003, open the template, right-click on the image, 

and navigate to Format Picture > Layout > Wrapping Style.  Select “INLINE” and save 

changes. 

b. In Microsoft Word 2007, right-click on the image, navigate to Text Wrapping and select 

“In Line with Text”. 

2. Use the URL Reference method within the template, keeping in mind that the image must 

reside on a publicly accessible server.  This method is recommended for use with e-mail 

communications. 

a. To do this in Microsoft Word 2000 or 2003, open the template and insert a dummy 

image.  Then, right-click on the image and select Format Picture.  In the Web tab, enter 

the following syntax in the Alternative text region to reference the image URL:  

url:{’http://image location’}.  For example, enter: 

url:{’http://www.oracle.com/images/ora_log.gif’}. 

b. To do this in Microsoft Word 2007, right-click on the image and select Format Picture.  

In the Alt Text tab, enter the reference to the image URL in the Alternative Text box. 

Note:  It is not possible to use the concat function method, as it is applicable to Oracle E-

Business Suite installations, and not PeopleSoft (e.g. 

url:{concat('http://webserver:port/ps/images/',//IMAGE,'.jpg')} where IMAGE is an element 

from the  XML file that holds the name of the image without file extension. 
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PRINTING BAR CODES 

Bar codes can be printed on envelopes when the font for bar coding is available on the 

Application Server, these fonts are loaded to XMLP, and the font property is set in the XMLP 

configuration file (or the font property is set in the template).  There are further instructions that 

can be found in the XML Publisher Core Components Guide.  Following is an overview of the 

steps involved: 

1. Place the font on the application server.  The font should be in a directory that is accessible 

to the formatting engine at runtime. 

2. Set the XML/BI Publisher font property either in the XML/BI Publisher configuration file 

or directly within the template, as explained below: 

a. To set the property in the configuration file, update the “fonts” section with the font 

name and its location on the server.  For example, the new entry for a TrueType font is 

structured as follows: 

<font family="MyFontName" style="normal" weight="normal"> 

<truetype path="\user\fonts\MyFontName.ttf"/> 

</font> 

b. To add property to a template, use the Microsoft Word Properties dialog box and enter 

the following information: 

• Name - enter the XML/BI Publisher property name prefixed with "xdo-" 

• Type - select "Text" 

• Value - enter the property value. To reference an element from the incoming XML 

data, enter the path to the XML element enclosed by curly braces. For example: 

{/root/password} 

Next, tell XML/BI Publisher where to find the font by setting the "font" property. 

Assume the font is located in "/tmp/fonts", enter the following in the Properties dialog: 

• Name: xdo-font.XMLPScript.normal.normal 

• Type: Text 

• Value: truetype/tmp/fonts/XMLPScript.ttf 

When the template is applied to the XML data on the server, XML/BI Publisher will 

look for the font in the /tmp/fonts directory. Note that if the template is deployed in 

multiple locations, verify that the path is valid for each location. 
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USING A SUB-TEMPLATE 

Sub-template files are independently stored, not registered in association with a data source or 

parent template, and not exposed to the end user at either report design time or runtime. 

Microsoft Word does not support form fields in the header and footer.  Therefore, you must 

insert placeholder syntax directly into the template using a sub-template.  Sub-templates are 

useful for containing common formatting, data fields and images that may be used in multiple 

templates, functioning for ease of reusability.  A single sub-template file may contain multiple 

sub-templates.  Following are guidelines for using sub-templates: 

• Start and end template indicators must exist to distinguish the various components (e.g. logo, 

signature) where subtemp equals the name of the sub-template, such as the example below: 

<?template: subtemp?> 

<?end subtemp?> 

• When using a sub-template, it needs to be referenced at the top of the parent template: 

<?import:psxmlp://subtemp_sub?> 

• For testing purposes while in Template Builder, the sub-template needs to reference a local 

path, similar to the following example: 

<!import:file://C:\Documents and Settings\USERNAME\CS Product 

Analysis\3Cs\Template Examples\subtemp.rtf?> 

(In the template, swap out the syntax of <? for <! to comment out the line.) 

• When using a sub-template, it must be registered in the Content Library by navigating to 

Reporting Tools > XML Publisher > Content Library.  When adding a new sub-template ID, 

it must be the same as the sub-template name used in the import line of the parent template. 

• There is no method for viewing which report templates include which sub-templates, other 

than viewing the parent template.  Users should be careful about changing, deleting, or 

inactivating sub-templates.  

Chapter 4 – Creating the Report Definition 

Report definitions associate the Communication Data Source with template files.  To create a 

Report Definition, navigate to Reporting Tools > XML Publisher > Report Definition. 

DEFINING THE DEFINITION 

When creating a new Report Definition, the Data Source Type must be “XMLDoc Object”.  In 

PeopleTools 8.5X, XMLDoc has been deprecated as a data source only for XMLP data sources 



Oracle White Paper—Campus Solutions 9.0 Communication Generation 

 

18 

created from the Reporting Tools menu.  Communication Generation uses Communication Data 

Sources created from the Campus Community menu only. 

On the Definition page, specific settings must be set: 

1. Report Status should be set to “Active”. 

2. Report Category ID should be “ALLUSER” (unless security has been set up differently). 

3. Template Type of “RTF” must be selected.  Once the Report Definition is saved, the 

Template Type cannot be changed. 

 

 

Figure 3:  Report Definition – Definition Page 

ASSOCIATING A TEMPLATE 

Users can associate one or more templates to the report definition.  Following are some 

guidelines: 

1. Select the Channel value of “Printer” for hardcopy communication methods.  Select “Email” 

for e-mail communications. 

2. At least one template must be active to save a report definition. 

3. The Preview button uses the sample XML data file to generate report output.  When 

selected, it generates readable output. 
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Figure 4:  Report Definition – Template Page 

REPORT OUTPUT PARAMETERS 

On the Output page, the Runtime Output Format Option is limited to using the Default value of 

“PDF” only for printing.  This current limitation is based on the need to convert from PDF to 

Postscript for printing, as well as functionality relating to enclosures, bursting, and sorting.  For 

e-mail, the default value can be “HTML”. 

 

 

Figure 5:  Report Definition – Output Page 
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SECURITY 

The Security page is used to indicate whether the report requestor can add to the standard 

Distribute To values on the Process Scheduler Request > Distribution Detail page.  A user can 

define the role(s) or user(s) who can both view the web-posted output in the Report Manager 

repository and use the XML Publisher Report Repository Search page by navigating to Reporting 

Tools > XML Publisher > XMLP Report Search. 

 

 

Figure 6:  Report Definition – Security Page 

BURSTING 

Bursting is an optional, advanced feature available when reports are run through the Process 

Scheduler.  When a bursted report is generated, the process creates separate files for each unique 

data value for a specified field tag.  Refer to Enterprise PeopleTools 8.XX PeopleBook:  XML 

Publisher for PeopleSoft Enterprise > Defining Report Definitions for detailed information 

relating to this functionality. 
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Figure 7:  Report Definition – Bursting Page 

Chapter 5 – Letter Code Setup 

Once the Communication Data Source has been registered, the template(s) have been finalized, 

and the Report Definition has been set up, there are additional parameters that must be defined 

relating to the associated letter code. 

DEFINING COMMUNICATION GENERATION PARAMETERS 

On the Campus Community Standard Letters page (Navigation:  Set Up SACR > Common 

Definitions > Standard Letter Table CS), the Letter Type must be set to “Softcopy” in order to 

make available the Define Comm Gen Parameters check box.  Once this check box is selected, 

the Report Name selection will be limited to reports in which the Administrative Function for 

the Data Source is equal to the letter code’s administrative function.  When the value is selected, 

it ties the Letter Code to the Report Definition. 

UTILIZING JOINT COMMUNICATIONS 

Communication Generation enables users to communicate jointly with individuals at a common 

address, rather than producing separate communications for each individual.  Following is a high-

level overview of the process: 

1. Define how two names will appear in the greeting and address portion of the 

correspondence by setting up the joint salutation on the Joint Salutation Type Table page 
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(Navigation:  Set Up SACR > Product Related > Campus Community > Establish People 

Processing > Setup > Joint Salutation Type Table). 

2. Set the Default Salutation Type on the Installation Defaults - CC page (Navigation:  Set Up 

SACR > Install > Campus Community Installation > Installation Default – CC). 

3. Create joint usages on the Name Usage page (Navigation:  Set Up SACR > Product Related 

> Campus Community > Establish People Processing > Setup > Name Usage Table). 

4. Review and update Relationship data by navigating to Campus Community > Personal 

Information > Biographical > Relationships > Relationships to set the relationship to Create 

Joint Communication, define the joint salutation, and identify the address to use for the Joint 

Address functionality. 

For joint communications, the communication should be assigned to only one of the individuals.  

If it is assigned to both, the process extracts the data for both IDs and generates two joint 

communications for the same two IDs. 

INCORPORATING ENCLOSURES 

The enclosure must have 3Cs set up exactly like the letter.  This includes a Communication 

Context, Communication Category, Speed Key and 3Cs security, as well as user defaults updated, 

to associate the enclosure to the letter.  The letter and all associated enclosure(s) must be 

assigned to the recipient. 

 

 

Figure 8:  Standard Letters Page 
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Chapter 6 – Assign Communications 

The communication can be assigned to the person or organization using the following options: 

1. Manually (Person Navigation:  Campus Community > Person Communications > 

Communication Management; Organization Navigation:  Campus Community > 

Organization Communications > Communication – Organization) 

 

 

Figure 9:  Communication Management - Person Communication Page 

2. 3C Engine (Navigation:  Campus Community > 3C Engine > Run 3C Engine) 

a. Batch – Population Selection, Trigger by Event, or Mass Change 
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Figure 10:  3C Engine – 3C Engine Parameters Page 

b. Online Triggers – User Profiles Management Process and Contributor Relations Gift 

Acknowledgement Process 

The PeopleSoft Process Scheduler is used to run the 3C engine process.  A user can run the 

process by selecting the IDs stored in the Trigger Table results, or by selecting the IDs using 

Mass Change Definitions or Population Selection, or a combination of the three. Familiarity of 

using this feature is recommended to generate communication assignments systematically. 

You can view the individual communication record (which has not yet been set to complete) by 

navigating to Campus Community > Person Communications > Communication Management 

or Campus Community > Organization Communications > Communication – Organization.  

You may also find it beneficial to create a query to verify the results using the 

COMMUNICATION record. 

Chapter 7 – Run Communication Generation 

Navigate to Campus Community > Communications > Communication Generation to run the 

Communication Generation process.  Running this process requires that parameters be set up on 

the Selection Parameters and Process Parameters pages.  When e-mail correspondence will be 

sent, the Email Parameters page must be set up. Lastly, when checklists are affiliated with the 

communication, the Checklist Parameters page should be completed. 

DEFINING SELECTION AND PROCESS PARAMETERS 

On the Selection Parameters page, a user has the option to select All IDs, All Org IDs, All 

Person IDs, One Org ID, One Person ID, or Population Selection.  Since multiple report 



Oracle White Paper—Campus Solutions 9.0 Communication Generation 

 

25 

definitions can be associated to one Letter Code, the Report Name link allows a user to select 

which report to use at run time. 

When the main letter code includes softcopy enclosures for the ID(s), the system populates each 

enclosure code and its relevant information in the Enclosures Assigned (Softcopy) section.  It is 

good practice to click the Refresh Enclosure List to capture any changes to the required 

enclosures relating to the main letter code each time the same run control ID is run. 

To identify the template for the Communication Generation Process to use, the Language and 

Method need to be selected. 

 

 

Figure 11:  Communication Generation – Selection Parameters Page 

On the Process Parameters page, if All IDs is selected, both the Person Communication Usage 

and Org Communication Usage sections must be completed.  Org Communication Usage values 

can be set up by navigating to Set Up SACR > Product Related > Campus Community > 

Establish People Processing > Setup > Organization Recipient Usage.  If All Person IDs or One 

Person ID is selected, the Person Communication Usage section needs to be completed.  If All 

Org IDs or One Org ID is selected, the Org Communication Usage section needs to be 

completed. 

The Joint Name field is available when the letter code is set to permit joint communications as 

defined in the Name Usage Table. 

IMPORTANT:  When sending e-mail communications, the Address must contain an e-mail address usage type. 

Following are options which can be selected in the Output Settings section: 
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• Online Preview – Preview a sample of a letter output online by navigating to PeopleSoft 

Report Manager > Administration page (Note:  When All IDs selected, this only selects the 

first 10 IDs and their enclosures and recipients).  This option does not cause communications 

to be marked completed and no information is entered in the Person or Organization 

Communication Management components.  When the communication method usage is E-Mail 

or Preferred, then an Email Address field appears.  When an e-mail address is entered, the 

process converts the output to HTML format and sends sample(s) of the generated output to 

the specified e-mail address and to Report Manager.  To view the format as a letter, remove 

the e-mail address and rerun the process. 

• Send to Printer – Enter the path to the printer (Example:  

\\<10.987.654.321>\printer_name\).  (Note:  Configuration is required to access a network 

printer by updating the BEA service to use a network account.). 

• Send to File – Enter the file path where the output goes in a Process Scheduler server directory 

location (Example:   \\<server.edu>\dfs\dept\peoplesoftdata\). 

(Note:  Create envelopes and create labels are discussed in a later section.) 

 

 

Figure 12:  Communication Generation – Process Parameters Page 

DEFINING EMAIL PARAMETERS 

The From and Subject parameters are required.  For the From e-mail address, it does not have to 

be valid; however, it requires the character of “@”.  If it is not valid, it is recommended that the 
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template include text clarifying this.  If the Reply to parameter is used, the value should be a valid 

e-mail address (overriding the From e-mail address). 

 

 

Figure 13:  Communication Generation – Email Parameters Page 

DEFINING CHECKLIST PARAMETERS 

The Checklist Parameters page provides flexibility to users, including the option to use multiple 

administrative functions, checklist types, checklist codes, checklist statuses, tracking groups, 

group statuses, and checklist item statuses. 

The Communication Generation process checks for the existence of at least one administrative 

function before attempting to extract any checklist information.  Whether or not one exists, the 

CHECKLIST_ITEMS folder will be part of the extract with “numrows = x” populated.  This is 

to satisfy the requirement for schema validation. 
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Figure 14:  Communication Generation – Checklist Parameters Page 

Chapter 8 – Reset Communication Generation Process 

The Reset Communication run control is an application engine process called SCC_CG_RESET.  

Navigation to run this process is Campus Community > Communications > Reset 

Communications. 

PURPOSE 

The Reset Communication Generation process enables users to reset communications records by 

clearing the Communication Outcome data (e.g. Communication Completed check box) and 

processing tables so that the Communication Generation process can be run again if it ended 

abnormally or an incorrect selection, such as a Template ID, was used. 

When the run status of the process instance number is Success, the process clears all information 

that was added to the communication record for each generated ID.  When the result status is 

No Success, Warning, Delete, Error, or Cancelled, all the processing tables are cleared so the 

Communication Generation process can be run again. 
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Figure 15:  Reset Communication Page 

Chapter 9 – Envelope and Label Generation 

Envelopes and labels can be generated using two different options:  (1) as an option on the 

Process Parameters page of the Communication Generation component, or (2) by running the 

Envelope and Label Generation process (an Application Engine process, SCC_CGLABELS). 

REQUIREMENTS 

The same setup for a letter communication is required for envelopes and labels, including 

defining a Communication Data Source, Template, and Report Definition. 

GENERATION OPTIONS 

When using the Communication Generation process to generate envelopes and labels, the 

process reuses the data extracted for the parent letter code report definition to merge with the 

envelope or label template.  Normally, the letter code is set to save data to the communication 

record.  When the Create Envelopes option is selected, the respective envelope is saved within 

each processed ID’s Communication Management component.  The Create Labels option does 

not allow for saving the respective label within the Communication Management component. 

When using the Envelope and Label Generation process (Navigation:  Campus Community > 

Communications > Envelope and Label Generation), the output can be generated for a hardcopy 

communication that does not have a template (e.g. postcard) or using the data assigned from a 

previous Communication Generation process.  Envelopes can be rerun without resetting and 

regenerating the communication.  The process recognizes and processes communications only 
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completed by the Communication Generation or Envelope and Letter Generation processes.  

The Communication Data Source associated with the Report Definition can use a different 

administrative function with this process. 

If more data is needed for either envelope or label template, the data must be extracted by 

modifying the Communication Data Source. 

The available styles appear in a drop-down menu next to the font selection box on the 

Formatting toolbar. In Microsoft Word 2007, click Ctrl+Shift+S to display the Apply Styles 

dialog box. Choose the style from the drop-down menu and then click Apply. 

 

 

Figure 16:  Envelope and Label Generation – Selection Parameters Page 
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Appendix A – Administrative Functions, Core Records, and 
Variable Data 

The following table provides details relating to the relationship of each administrative function 

and its core records and variable data used for extracting communication data. 

 

Administrative Function 

Code 
 

Administrative Function Core Record Variable Data Fields 

ADMA Admissions Application ADM_APPL_DATA ACAD_CAREER 

STDNT_CAR_NBR 

ADM_APPL_NBR 

ADMP Admissions Program ADM_APPL_PROG ACAD_CAREER 

STDNT_CAR_NBR 

ADM_APPL_NBR 

APPL_PROG_NBR 

AVAK Advancement 

Acknowledgements 

AV_RCG_DES BUSINESS_UNIT 

DESIGNATION 

GIFT_NO 

INTV_CD 

RECOGNITION_TYPE 

SESSION_NO 

AVIN Advancement Initiatives AV_INITIATIVE AUD_TYPE 

AV_AUDIENCE 

INTV_CD 

AVMS Advancement Membership AV_MEMBERSHIP AV_MBR_ORG_COD 

BUSINESS_UNIT 

MEMBERSHIP_NBR 

AWRD Awarding STDNT_AWARDS ACAD_CAREER  

AID_YEAR 

ITEM_TYPE 

EVNT Event EVENT_MTG CAMPUS_EVENT_NBR 

EVENT_MTG_NBR 

FINA Financial Aid STUDENT_AID AID_YEAR  

GEN General   

IHC International Health Coverage SSF_IHC_STDNT SSF_IHC_COVER_NBR 

ISIR ISIR Corrections ISIR_CONTROL AID_YEAR 

EFFDT_VAR 

EFFSEQ_VAR 
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Administrative Function 

Code 
 

Administrative Function Core Record Variable Data Fields 

LOAN Loan LOAN_ORIGNATN AID_YEAR  

ACAD_CAREER 

LN_APPL_ID 

LN_APPL_SEQ 

LOAN_TYPE 

PROP Prospect Program ADM_PRSPCT_PROG ACAD_CAREER 

ACAD_PROG 

PROS Prospect ADM_PRSPCT_CAR ACAD_CAREER  

PSSV Prospect Self Service ADM_PRSPCT_CAR ACAD_CAREER  

RECR Recruiters  ACAD_CAREER  

RSTR Restricted Aid STDNT_RSTRC_AID AID_YEAR 

RESTRICTED_AID_ID 

SFAC Student Financials Account ACCOUNT_SF,  

ACCOUNT_ORG_SF 

ACCOUNT_NBR 

ACCOUNT_TERM 

BUSINESS_UNIT 

SFBI Student Financials Billing BI_BILL_HEADER BUSINESS_UNIT 

INVOICE_ID 

SFCO Student Financials Collections COLLECTION_SF BUSINESS_UNIT 

COLLECTION_ID 

SFGR Student Financials Groups GROUP_CONT_INFO BUSINESS_UNIT 

GROUP_ID_SF 

SFIT Student Financials Item Lines ITEM_LINE_SF BUSINESS_UNIT 

ITEM_NBR 

LINE_SEQ_NBR 

SFPA Student Financials Payments PAYMENT_TBL BUSINESS_UNIT 

PAYMENT_ID_NBR 

SFRC Student Financials Receipt CSH_OFF_RECEIPT BUSINESS_UNIT 

CASHIER_OFFICE 

RECEIPT_NBR 

SFRF Student Financials Refund REFUND_HDR BUSINESS_UNIT 

REFUND_NBR 

SFTP Student Financials Contracts TP_STUDENT 

TP_CONTRACT 

BUSINESS_UNIT 

CONTRACT_NUM 

SPRG Student Program ACAD_PROG ACAD_CAREER 

STDNT_CAR_NBR 

STRM Student Term STDNT_CAR_TERM ACAD_CAREER 

   STRM 
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Appendix B – Diagnosing Common Errors 

Following are tables to assist in diagnosing and troubleshooting common errors and issues 

relating to the Communication Generation process: 

COMMUNICATION DATA SOURCE COMPONENT (SCC_CG_DTASRC) 

Error or Issue How to Resolve 

“No Report Definitions found.  Make sure Letter Code 

is properly set up. (14100,878) 

SCC_COMMGEN.Model.DSAdapters.PSQueryAdapt

er.OnExecute  Name:Validate  PCPC:1684  

Statement:31 

Process 10276 ABENDED at Step 

SCC_COMMGEN.Process.Step20 (PeopleCode) -- 

RC = 24 (108,524)”. 

Remove the value in the Set Letter Code field on the 

Standard Letters page by navigating to Set Up SACR > 

Common Definitions > Communications > Standard 

Letter Table CS. 

Cannot find Query to select as Communication Data 

Source. 

The query needs to have a core record relating to the 

administrative function (see Appendix A). 

 

COMMUNICATION GENERATION COMPONENT (SCC_CG_RUNCTL) 

Error or Issue How to Resolve 

“Organization Recipient Usage is Required. 

(14000,459)”. 

When All IDs is selected, organization parameters must 

be populated on the Process Parameters page.  To 

avoid this error, navigate to Set Up SACR > Product 

Related > Campus Community > Establish People 

Processing > Setup > Organization Recipient Usage and 

add a usage. 

Cannot retrieve Letter Code on Communication 

Generation > Selection Parameters page. 

The speed key needs to be added to the User Defaults 

component by navigating to Set Up SACR > User 

Defaults > Communication Speed Keys. 

 

COMMUNICATION GENERATION PROCESS (SCC_COMMGEN) 

Error or Issue How to Resolve 

“Error generating output file for letter communication. 

(14100,734)”. 

This may be an issue when the web server, app server, 

and process scheduler are on 3 separate machines.  

Please refer to Knowledge Doc ID 661121.1 for solution. 

“Error generating report output: During calling 

method PTFOProcessor.generateOutput, the XDO 

engine throws an exception: NULL. (235, 3101) 

(235,2309).” 

This may be an issue when the web server, app server, 

and process scheduler are on 3 separate machines.  

Please refer to Knowledge Doc ID 661121.1 for solution. 
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COMMUNICATION GENERATION PROCESS (SCC_COMMGEN) 

Error or Issue How to Resolve 

“Error removing directory 

\\PSTST43\PSLS\fred\CG_167886: file or one of its 

subdirectories was not removable: The specified 

directory could not be removed. (2,828)”. 

This may be an issue when the web server, app server, 

and process scheduler are on 3 separate machines.  

Please refer to Knowledge Doc ID 661121.1 for solution. 

“No valid queries found in the first 300 items 

evaluated.” 

The query used with the Communication Data Source, 

which should be used to select the additional data that is 

needed for the letter or e-mail, should include a prompt 

for each of the variable data items relating to the 

administrative function (see Appendix A). 

“PSPAL: Abort: Unrecoverable signal 22 received 

PSPAL: Abort: Location: e:\pt849-903-R1-

retail\peopletools\SRC\pspal\exception_winunhandle

d.cpp:357: 

PSPAL::UnhandledExceptionFilter::SignalExceptionF

ilter” 

In the process scheduler definition, add Java parameters 

for max and min JVM. 

Unable to extract e-mail addresses to send 

communications. 

On the Communication Generation > Process 

Parameters page, address type usage selected must 

contain at least one e-mail type.  To add or modify an 

address type, navigate to Set Up SACR > Product 

Related > Campus Community > Establish People 

Processing > Setup > Address Usage Table. 

 

COMMUNICATION MANAGEMENT COMPONENT (COMM_MANAGEMENT) 

Error or Issue How to Resolve 

Unable to clear Process Instance in communication 

record. 

Run the Reset Communication process by navigating to 

Campus Community > Communications > Reset 

Communication. 

 

REPORT DEFINITION COMPONENT (PSXPRPTDEFN) 

Error or Issue How to Resolve 

“Error generating report output: During calling 

method PTFOProcessor.generateOutput, the XDO 

engine throws an exception: NULL. (235, 3101) 

(235,2309).  Error occurred during the process of 

generating the output file from template file, XML 

data file, and translation XLIFF file.” 

The Channel on the Report Definition Template page 

needs to be set to “Printer” for letters or “HTML” for 

email.  On the Output page, the location should be set to 

“Any”. 
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REPORT DEFINITION COMPONENT (PSXPRPTDEFN) 

Error or Issue How to Resolve 

Cannot open the Report Definition component online.  

User gets “Invalid XSD File: Expected 'EOF'. 

(235,18)  This XSD file is not valid.  Please correct 

the error and upload again.” 

The Data Source may be corrupt.  Create a new 

Communication Data Source, register the Data Source, 

create a new Report Definition, attach the template, and 

run the Communication Generation process. 

Cannot select a Data Source Type when adding a 

new Report Definition. 

There is an issue with security access.  The User ID 

must have the delivered Security Role ‘XMLP Report 

Developer’, which includes PTPT2600. 

Cannot view output after clicking Preview button on 

Report Definition > Template page. 

There may be a problem with the SQL relating to the 

query being used as part of the Data Source (e.g. 

missing core record relating to the administrative 

function, prompt for EMPLID needs the Unique Prompt 

Name changed to PERSON_ID, prompts needed for 

variable data). 
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Appendix C – Resources 

• DEFINING IF-THEN-ELSE STATEMENTS IN MICROSOFT WORD 

(HTTP://OFFICE.MICROSOFT.COM/TRAINING/TRAINING.ASPX?ASSETID=RP01

1205961033&CTT=6&ORIGIN=RP011205871033) 

• HTTP://BIPUBLISHER.US.ORACLE.COM/ 

• KNOWLEDGE DOC ID 661121.1  COMMUNICATIONS USING COMMGEN/XML 

PUBLISHER ARE NOT WRITING OUT PROPER .PDF FILES 

• KNOWLEDGE DOC ID 662777.1  XMLP:  ERROR WHEN PUBLISHING XML – THE 

SYSTEM CANNOT FIND THE PATH SPECIFIED 

• KNOWLEDGE DOC ID 662933.1  E-XMLP HOW TO USE BURSTING AND 

MULTIPLE TEMPATES  

• KNOWELDGE DOC ID 663070.1  E-XMLP:  GETTING ERROR “ERROR 

GENERATING REPORT OUTPUT: (235,2309)” 

• KNOWLEDGE DOC ID 664523.1  E-XMLP REPORTS GET 

OUTOFMEMORYERROR AND GENERATES HEAPDUMP AND JAVACORE FILES 

• KNOWLEDGE DOC ID 962712.1  E-XMLP PERFORMANCE TUNING XMLP 

REPORTS 

• ORACLE UNIVERSITY COURSE OFFERINGS 
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Appendix D – Revision History 

1. 8-February-2010:  Completed first draft of document. 

2. 9-February-2010:  Submitted for review. 

3. 26-February-2010:  Submitted for final review. 

4. 3-March-2010:  Posted to My Oracle Support. 
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